
12/08/2022

1

Troubleshooting the Teacher 
Licensure Course Status Report 

The Ohio Department of Education funds development of EMIS training materials 
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these 
materials in training provided to your districts. That said, there are restrictions on 
use of the EMIS Alliance materials as follows: Materials developed as part of the 
EMIS Alliance program must be provided at no cost to your training participants. If 
you utilize the EMIS Alliance training materials – in whole or in part – you must not
charge participants a fee to attend the class where the materials are used. Likewise, 
you may not use the materials or any portion thereof in any event where a fee is 
charged to attend. Exceptions must be approved in writing by the Department of 
Education in advance of scheduling/promoting any event which may violate these 
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Overview

• Teacher Licensure Course (TLC) Status Report
• Includes all courses reported to EMIS and the proper certification 

status of the teacher of record 

• Is generated for all EMIS reporting entities and updated nightly 

• Is used to provide data for Local Report Cards (LRC), certain state and 
federal funding, and for ODE program evaluation and planning

• This presentation will focus on troubleshooting the TLC Status 
Report, which is generated during the Initial Staff and Course 
(L) Collection
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Certification Data on LRC
The LRC contains data from the Initial Staff and Course 
Collection that is used to populate the school or district details

https://reportcard.education.ohio.gov
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TLCS Data Uses 

• ODE Federal Programs Office to audit the use of Title I Funds to 
generate the ESSA State Licensure Assurances Report
• 20##L_PRIN_ESSA_Licensure_Assurances_<file date>.pdf
• Arrived as a Received file in FY22 in February 2022
• Displays all core courses, by staff member, and building
• Report contains instructions and ODE contact information 
• See EMIS Validation and Report Explanations > File Descriptions on the 

ODE website for additional information
• ESSA requires schools and programs receiving Title I funds to ensure that 

all teachers and paraprofessionals working in a program supported with 
these funds meet applicable State certification and licensure 
requirements 

• Wrong staff name on ESSA report?
• two districts report the same state ID but with different names attached
• Incorrect name does not impact actual data since ODE only uses State Staff ID
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TLCS Data Uses, cont’d 
• By the ODE Office of Educator Effectiveness to provide districts the 

Equitable Access Analysis Tool to use for Title I equity planning
• Contains Percent and FTE of teachers who are not properly certified

• Same as last year, districts will access this via the SDC in January
• Uses previous year’s data – FY22 reporting will be used by your district in FY23

• Questions – equity@education.ohio.gov

• Local equitable access planning requirement in the ED STEPS
• The tool allows educators to identify where, and to what extent, any inequities in access to 

excellent educators exist

• https://education.ohio.gov/Topics/Teaching/Educator-Equity/Educator-Equity-in-Ohio/Local-Equity-Plan-1
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TLC Status Report 

To access the TLC Status Report, select the Level 2 Reports link 
from the Staff and Course Collection – Initial (FY23) 

But first, let’s take a quick look here 
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View Submission Data > Generate Review Data 
Verify data in the Initial Staff and Course Collection

Are there invalid records that need to 
be corrected? Review Level 1 Validations. 

Are there Excluded Records 
that are preventing data 
from being reported? 

Are there missing staff records?

Incorrect data = Incorrect TLC Report12/08/2022 8
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TLC Status Report - Level 2

Verify that filters are correct 
then select “Show Reports”
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Formatting the TLC Status Report

• Open the (TLCS-001) Teacher Licensure Course Status Report
• Wrap text header row

• Freeze top row

• Expand all columns

• Apply filters

• Better yet, use your macro! EMIS Alliance Excel 
• https://community.mcoecn.org/display/EM/FY22+EMIS+Alliance+Using+Excel+to+Troubleshoot+EMIS+Data

• https://community.mcoecn.org/display/EM/FY21+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data

• https://community.mcoecn.org/display/EM/FY20+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data

• https://community.mcoecn.org/display/EM/FY19+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data

• https://community.mcoecn.org/display/EM/EMIS+Alliance%3A+FY18+Using+Excel+to+Troubleshoot+EMIS+Data
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Quick Check • Are you using the most recent version 
of the report?
• TLC
• ESSA State Licensure Assurances
• Equity Analysis

• Have you corrected Level 1 Validation 
errors, excluded records, and missing 
staff?

• Are you able to open and format your 
TLC Status report? 

The TLC Status Report is 
updated nightly and should 
be reviewed throughout the 
Initial Staff and Course 
Collection. Data on your 
report could appear based on 
another entity’s reporting, so 
review the report even when 
you are not reporting any 
changes. 
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Understanding 
the TLC Status Report
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TLC Status Report Data 

• Data from the following collections are used to generate the TLC Status 
Report
• Staff and Course (L) Collection - Initial
• Final Calendar (C) Collection 
• Beginning of Year Student (S) Collection
• Midyear Student (S) Collection
• SOES Beginning of Year Student (S) Collection
• SOES End of Year Student (S) Collection

• Verify data is correct and complete in ALL noted collections
• Report is generated nightly with data submitted by 5pm throughout the 

Initial Staff and Course Collection 
• The TLC Status Report is finalized at the close of the Initial Staff and Course 

(L) Collection 
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TLC Status Report Data
Contains one row per Local Classroom Code 

• First 11 columns include:
• Location IRN of the building where the course is being taught

• Subject Code, Description, and Local Classroom Code

• Teacher of Record and State Staff ID

• Blank or incorrect staff name 
• CJ record issue – not reported by another EMIS reporting entity (example: ESC)

• Could be due to upper- and lower-case letters in state staff ID - Verify ID

• Create helpdesk ticket to ask ODE about blank or missing names if needed

Severity Codes align with Result Codes which 
will be discussed in upcoming slides12/08/2022 14
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Verify Staff and Courses
• Do not focus on errors only; review the entire report for accuracy and 

completeness
• Are all building IRNs appearing on the report? 

• Are all teaching staff appearing as they should? 

• Are all courses for each building appearing on the report? 

• Remember that total courses are the denominator for Local Report Card 
staff percentages, so it’s important that every course is accounted for
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Teacher of Record 
• The teacher who appears on the TLC Status Report is based on 

• Teacher with greater amount of time teaching the course 
• Multiple teachers teaching the same amount of time

• Uses first teacher the report finds who is properly certified 
• If none are properly certified, the report uses the first teacher it comes to

• It could change from report to report depending on the processing order

• No proper credential found
• Uses first teacher reported on the course

• See ODE ITC EMIS Training November 2021 & 2022 for 
additional information
• https://education.ohio.gov/Topics/Data/EMIS/EMIS-Resources/EMIS-

Training
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Course and Calendar Dates 

• Dates are used to determine a “course calendar” 
• Grade Schedule (DL) Record - First and Last Day of School
• Course Master (CN) Record - Course Start and End Date
• Staff Course (CU) Record - Staff Course Start and End Dates
• Student Course (GN) Record - Course Enrollment Start and End Date 

• The “course calendar” is then used to determine 
• Teacher who was with the course the longest
• Students who are counted as being in the class
• Location IRN is used for course calendar assignment 

• Misaligned dates can cause teachers to appear as not properly certified
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Location IRN

The building IRN where course is being taught
• District IRN should not be reported as the Location IRN

• Applies to LEAs that have both district and building IRNs
• Traditional Districts

• Refer to reporting instructions in the EMIS Manual for Location IRN 
in section 4.2 Course Master (CN) Record

• Filter TLC Report for Location IRN
• Unselect local building IRNs

• Verify Location IRN’s reported outside of District 

• Local district IRN should be changed to building IRN (when applicable)
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Location IRN

A few exceptions (not a complete list)  
• IRN of college who is granting credit for CCP course

• For CCP Course with delivery method of CP report the IRN of the 
location of the course per the CTE-26

• IRN of the location of the JVSD satellite course 

• IRN of the building associated with the preschool license 
• See additional reporting instructions for the Location IRN in the 4.2 

Course Master (CN) Record section of the EMIS Manual 

12/08/2022 19

TLC Status Report Columns
Moving to the right, the next set of columns L through P contain 

• Result Codes with Descriptions
• Proper Certification Flag (Yes or No)
• Calculated TLC IRN (derived from reported data) 
• LEA IRN (IRN of the LEA reporting the course) 

Calculated TLC IRN is 
derived from reported data

LEA IRN is entity 
reporting the course

12/08/2022
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TLC Status Report Columns, cont’d
Course elements – appear on the report for ease in troubleshooting

• Curriculum Code
• Delivery Method Code
• Education Options Code  
• Student Population 

• Population of students for whom the curriculum is intended and not about the students who are actually enrolled

Different errors for the same staff member over multiple reports
• Both result codes (TLxxxx) could apply 
• Error can change due to the order in which things are processed
• Could potentially change from report to report
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Special Ed vs Regular Student Population

Student population reported based on the content/structure of the course 
• If modified for special education population, report with an SE student population

• Teacher must hold a special education license to appear as properly certified for an 

SE course 

• Certification and Licensure Search does not include courses coded with a student 

population = SE
• As far as the TLC Status Report is concerned, someone with a special ed license can teach any 

subject in a special ed classroom

• If not modified for special education population, report with an RG student population

• Teacher must hold a regular education license to appear as properly certified for an 

RG course 

• Do NOT modify student population to remove an error

• Always report “What is”
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TLC Status Report Columns, cont’d

Columns U through AJ contain
• Count of students enrolled in the course by state equivalent grade 

level (both regular education and students with disabilities)

12/08/2022

Cells can be blank if there are no students enrolled in the course
Or the students are not being populated onto the report
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TLC Status Report Columns, cont’d
Far right columns contain

• Counts of students with disabilities and the percentage of those students 
in the course

• Credential Course Disability Indicator Code with Description 

• Reported TLC IRN, Check Type Code and Provider IRN

12/08/2022 24

23

24



12/08/2022

13

Reported TLC IRN

• IRN of the building where this course will be used in the 
calculation of the percentage of core courses taught by 
properly certified/licensed staff

• Local, exempted village, or city school districts can report the 
IRN of one of their own buildings but should not report their 
district IRN for the TLC IRN

• Refer to EMIS Manual 4.3 Staff Course (CU) Record to review 
all reporting instructions for this element
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Core or Non-core? 
EMIS Manual section 4.7 Subject Codes A value in this column 

indicates CORE subject 
area while “—” 
indicates a non-Core 
subject code 

Core subject codes

Non-Core subject code 
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Reported TLC IRN, cont’d 

• Report ****** for non-core courses and for core courses where
• Curriculum element is 

• OC – Expert Contracted from Outside Company/Organization for Credit Flex, 
PS- College Credit Plus, or PI – Postsecondary Instructor (not CCP) 

• or Delivery Method is 
• CC – Correspondence Course, ET – Educational Travel, or OL - Online, and

Educational Option is Yes

• or Delivery Method is 
• ID – Interactive Distance Learning, IM – Internship/Mentorship, TO – Test Out, 

or CI – Computer as Instructor

• or Student Population is 
• D8 – Preschool Special Education, DP – Preschool Special Education 

Hearing/Visual, or PR – Preschool General Education 
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Reported TLC IRN, cont’d
• When contracting a teacher of record from an EMIS reporting 

entity
• Two common situations-
• Contracted teacher is teaching only your students in a 

course in your building 
• Report the building IRN as the TLC IRN (same as Location IRN)

• Contracted teacher is teaching students from multiple 
districts 
• Report the district IRN of the contracted entity (Location IRN is 

building where class is being taught)

• See 4.3 Staff Course (CU) Record section of the EMIS Manual 
for additional reporting instructions 
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Reported TLC IRN, cont’d

• Courses reported with a TLC IRN of another EMIS Reporting LEA 
should appear on both LEA’s TLC Status Reports when reported 
correctly 
• Contractor Staff Employment (CJ) Records are required to be 

reported by the entity employing the staff member but are 
not needed for the course and staff to appear on both 
contracted entity’s TLC Status report

• Work with contracted EMIS Reporting entities to verify that 
teachers and their courses are appearing correctly

• Reporting Example
• District A reports courses

• ESC reports CJ record
12/08/2022 29

Staff Provider IRN
Reported on the Staff Course (CU) Record

• District IRN of the EMIS Reporting entity who employs the contracted 
staff

• Cannot be an IRN of a Non-EMIS Reporting entity

• Should be reported as ****** if the staff member is not being 
contracted from another EMIS reporting entity 

• Must be reported when the entity reporting the course is not 
reporting Staff Demographic (CI) and Staff Employment (CK) records 
for the staff member

• Filter on Staff Provider IRN to verify accuracy of reporting
• Unselect ******

• Verify remaining Staff Provider IRN for accuracy
12/08/2022 30
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Derived Elements on TLC Status Report 
• Calculated TLC IRN 

• In most cases the calculated TLC IRN will match the TLC IRN reported for 
core courses

• could be set to match the Location IRN when TLC IRN is reported as 
****** or reported with an IRN that is not a valid public school

• non-core courses will be set to ******

• Credential Course Disability Indicator
• derived from reported student population and students with disabilities 

who are enrolled in the course

• are used to determine the Check Type 

• Check Type Code 
• indicates the credential check that was used 
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Credential Course Disability Indicator A

Filter on A - Student Population of DP or SP
• DP-Preschool Special Education Hearing/Visual 

• SP-Special Education K-12 Hearing/Visual 

• More than 50% of the students in the course must have a disability 
condition
• Of these students, more than 50% must have a disability condition of 

• 1 (Multiple Disabilities-Other than Deaf-Blind)

• 2 (Deaf-Blindness)

• 3 (Deafness-Hearing Impaired)

• Can be all 3s or some combination of these three disability conditions

• Check Type Code is S – Special Situation Check 
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Credential Course Disability Indicator B

Filter on B - Student Population of DP or SP
• DP-Preschool Special Education Hearing/Visual

• SP-Special Education K-12 Hearing/Visual 

• More than 50% of the students in the course must have a disability 
condition
• Of these students, more than 50% must have a disability condition of 

• 1 (Multiple Disabilities-Other than Deaf-Blind)

• 2 (Deaf-Blindness)

• 4 (Visual Impairments)

• can be all 4s or some combination of these three disability conditions

• Check Type Code is S – Special Situation Check 
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Credential Course Disability Indicator C

Filter on C - Student Population of D8 or SE
• D8 - Preschool Special Education

• SE - Special Education K-12

• More than 50% of the students enrolled in the course must have a 
disability condition

• Course cannot fit into codes A or B
• Check Type Code is S – Special Situation Check 
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Credential Course Disability Indicator D

Filter on D - Student Population of DP, D8, SE, or SP
• DP - Preschool Special Education Hearing/Visual

• D8 - Preschool Special Education

• SE - Special Education K-12

• SP- Special Education K-12 Hearing/Visual 
• 50% or fewer of the students enrolled in the course have a 

disability condition

• Check Type Code is R – Regular Check
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Credential Course Disability Indicators E and Z

Filter on E - Student Population of GA or GE
• GA - Gifted Education in arts delivered by trained arts instructor K-12
• GE – Gifted Education K-12
• Check Type Code is S – Special Situation Check 

Filter on Z - Student Population of PR or RG
• PR – Preschool General Education
• RG – Regular/General Education 
• Check Type Code is R – Regular Check

Filter on X – Does not fit into categories A, B, C, D, E, or Z
• Rare
• Means none of the above
• Verify proper certification flag has been set properly
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Regular Check Type Code R

Filter on R – Regular Check 
• Majority of courses

• Educational Option = No
• Student Population 

• RG - Regular/General Students K-12
• PR – Preschool General Education

• Delivery Method = FF – Face to Face and OL – Online
• Curriculum code 

• AP – Advanced Placement
• IA – International Baccalaureate AB INITO
• OT – Curriculum not specifically covered by another option
• Career Tech Codes 
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Special Situation Check Type Code S

Filter on S – Special Situation Check
• Educational Option = No

• Student Population
• DP - Preschool Special Education Hearing/Visual

• D8 - Preschool Special Education

• GA - Gifted Education in arts delivered by trained arts instructor K-12

• GE - Gifted Education K-12

• SE - Special Education K-12

• SP - Special Education K-12 Hearing/Visual 
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Any Certification Check Type Code A or N
Filter on A – Any Certification Check

• Educational Option = YS *OR*
• Delivery Method of 

• CI – Computer as Instructor
• ID – Interactive Distance Learning
• IM – Internship/Mentorship 

Filter on N – No check required 
• Courses with Curriculum Element 

• OC – Expert Contracted from Outside Company/Organization for Credit Flex
• PI – Postsecondary Instructor 
• PS – College Credit Plus 

• Educational Options = YS
• Delivery Method = TO, ET, IS, IM, OT (community service, work-based 

learning)
12/08/2022 39

Community School Check Type Code C

Filter on C – Community School Course 
• Traditional district regular checks are run and if the Properly 

Certified Flag is set to N, additional checks are run that allow for any 
regular teaching license or any substitute license

• This does not apply to special education checks
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Quick Check • Have you reviewed your EMIS data 
for accuracy and completeness?

• Are all courses and teaching staff 
appearing on the report? 

• Have you shared the data with 
staff who can assist with data 
verification? 

The TLC Status Report uses a 
wide variety of data from 
many different collections. 
Taking time to verify that 
EMIS data is correctly 
reported will result in a 
clearer, more accurate TLC 
Status Report. 
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CORE Educator Search 
and Certification and 

Licensure Search
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CORE Database

The TLC Status Report 
• looks at each course and at data regarding the teacher’s current 

credentials from the CORE database 

• determines if the staff member is appropriately credentialed to 
teach the 
• subject code

• student population

• grade level(s) of the students scheduled in the course

• Use the CORE Database/Educator Search to review teacher 
licensure information
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Educator Licensure & Records > Educator Profile

OR click either link 
to log into OH|ID to 
access the CORE App

OR
CORE App 

https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.UI/

12/08/2022

Access publicly 
from this page 
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Demographic Information

Credentials are listed along with 
additional information below

Note the active license/certification 
and teaching fields
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Educator Credential Data by District 

Choose a school and then 
“Select” to download a 
spreadsheet of educator data 

In the Educator Profile dropdown menu, 
select Educator Data by District

12/08/2022 46

45

46



12/08/2022

24

Teacher with Two Licenses

This teacher had a one-year 
license that is only valid in 
this district as well as a 5 
year license

Note any limitations, teaching 
fields, or endorsements that 
may be listed

12/08/2022
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Certification and Licensure Search
READ ME

Link 1

Link 2

Student Population
PR – Preschool General Education
RG – Regular/General Students K-12

Student Population
DP – Preschool Special Education 
Hearing/Visual
D8 – Preschool Special Education
GA – Gifted Education in Arts…K-12
GE – Gifted Education K-12
SE – Special Education K-12
SP – Special Education K-12 
Hearing/Visual
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Link 1 – Special Education 
Special Education Certification Information

Assignment area 999414 
Special Education K-12

READ ME

Student Population
SE – Special Education K-12
SP – Special Education K-12 
Hearing/Visual 

General Rule 
and Exceptions
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Link 2 - Teaching Certificate & License Search
Click on the Cert/Lic. Type link
to see a list of License Types 
(this is not a complete list)

999370 - General Education K-12 
and 999800 Career-Technical 
Programs/Career Pathways 
12/08/2022 50
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Search for Valid Subjects Search by Certification/
License Type and Teaching 
Fields and Endorsements 

Results are a list of subject codes and 
grades that this combination of 
Certification/License Type and codes 
is properly certified to teach
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Search for Valid Certificates/Licenses 

Search by 
Subject Code

Results are lists of certificates/licenses 
along with teaching fields and grade levels 
that can teach this subject code
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Quick Check • Are you able to use the CORE 
Educator Search Tool to view 
certification data? 

• Can you search using the 
Certification and Licensure Search 
by certification or subject code?

• Are you involving your district’s 
Human Resources staff in this 
process? 

The TLC Status Report checks 
against the CORE database to 
determine if a teacher is 
properly certified to teach a 
specific course. Searching the 
database can aid in 
troubleshooting the report. 
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TLC Status Report Result Codes 
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Properly Certified Result Codes

• Filter on TLC Result Code TL0001 (Informational)
• Core Course 

• Proper Cert Flag = Y

• Filter on TLC Result Code TL0002 (Informational)
• Not Core Course

• Proper Cert Flag = Y

• Verify the data to be correct and complete
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Not Properly Certified - No Students in Course

Filter on TLC Result Code TL0005 (Critical)
• Student Grade Count columns for this course will contain blank 

values 

• Verify that no students are enrolled in the course 
• These courses will not negatively impact the LRC and can be reported, 

however, the row will remain as a critical

• These courses could negatively impact CTE funding. If this is a future term 
course, schedule students into the course or you will need to request an 
override from CTE if it is not CTE FTE funded
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Not Properly Certified - No Students in Course, cont’d

Continue filtering on TLC Result Code TL0005 (Critical)
• Are there students being reported as enrolled in the course?

• Check the dates to be sure they are aligned
• Calendar start and end dates 

• Uses the most common calendar dates for the majority of students in 
the course 

• Course Master (CN) Record start and end dates 

• Staff Course (CU) Record start and end dates

• Student Course (GN) Record enrollment start and end dates 

• If there are truly no students enrolled in the course at any point during 
the school year and this is not a CTE course, then result code can be 
ignored
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Not Properly Certified – Credential/Course 

No Current Credential or Incorrect Student Population

Filter on TLC Result Code TL0006 (Fatal)

• Staff not certified to teach this subject code or student 
population 
• Check certification to see if they can teach the subject code
• Check the student population, is it correct? 

• Check the students who are enrolled in the course to verify that 
they align with the student population element

• Filter by that staff member to see all courses and student 
populations to verify
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Not Properly Certified – Credential/Course, cont’d 

Could be a career technical course that requires an override
• VM overrides are now automated 

• Questions regarding CTE overrides can be sent to
• CTETeacherOverride@education.ohio.gov

• Will continue to be not properly certified on the TLCS Report
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Not Properly Certified – Credential/Course, cont’d 

• ODE ITC EMIS Training (Nov. 2022) Q/A
• Q1. IF a CTE teacher is on the TLC Status Report as not properly certified, do we need 

to request a CTE override for that teacher? 
• A1. Remember that the override allows the funding to flow but does not change that 

the teacher is not properly certified. These overrides impact your CTE FTE report, not 
your Teacher Licensure Course (TLC) Status Report; teachers will continue to appear 
as not properly certified even when an override is granted.

• Q2. I have teachers teaching courses without the appropriate credential. In the 
second semester, the teachers will change to those with proper licensure. Will that 
be reflected correctly in the Final Staff and Course (L) Collection? 

• A2. Yes, the Final Staff and Course (L) Collection will have those teachers reported; 
however, remember that the TLC Status Report only uses data reported in the Initial 
Staff and Course (L) Collection. If the teacher change is not reported in the initial 
collection, the new teacher will not be reflected on the report.
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Not Properly Certified - Substitute

Substitute Credential for traditional districts

Filter on TLC Result Code TL0007 (Fatal)
• A long-term substitute can appear as properly certified when reported 

by a community school

• Substitute teachers who are providing instruction and assigning grades 
should be reported as the teacher of record, even if the teacher will be 
returning
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Not Properly Certified - Org IRN

Org IRN Not Matching

Filter on TLC Result Code TL0008 (Fatal)
• Questions about these situations should be directed to the Office of 

Educator Licensure 
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Not Properly Certified – Grade Level 
Students Outside Grade Range for Credential

Filter on TLC Result Code TL0009 (Fatal)

• More than 50% of students enrolled must be within the grade levels 
on the teacher’s credential

These credentials 
allow the teacher to 
teach students in 
grades K-8
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Not Properly Certified – No Staff Course Record 

No Staff Course (CU) Record

Filter on TLC Result Code TL0010 (Fatal)
• Teacher name will not appear on the TLC Status Report 
• Check Level 1 Validations for fatal or dependent errors 

that could cause the Staff Course (CU) Record to not be 
reported

• Check for State Staff IDs that contain lower case letters 
• Check for missing CJ records from a contracted staff 

reporting relationship
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Quick Check • Are you reviewing the TLC Status 
Report regularly? 

• Are you reporting data accurately 
to EMIS? 

• Are you working with district staff 
to verify the data? 

The TLC Status Report 
performs teacher certification 
checks using your EMIS data, 
as well as data from other 
LEAs, against the CORE 
database. Verify that your 
data is correct prior to the 
close of the Initial Staff and 
Course Collection. 
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Color Fill and Sort 
• Review the report by teacher

• Clear all filters 
• Data tab > Sort by Proper Cert Flag column (A-Z)
• Highlight all rows with Proper Cert Flag = N

• Color Fill – select a color ☺

• Select Cell A1
• Data tab > Sort by Last Name and First Name 

• Scroll through report and note-
• Staff member’s courses are showing as properly certified 
• Staff member’s courses are showing as not properly certified 

(highlighted rows)
• Staff member’s courses are appearing with some courses properly 

certified and some not properly certified (non-highlighted rows)
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Pivot Table – Proper Cert Flag by Teacher  

Create Full Name Column using Concatenate 
• Select column K

• Right click and select “Insert” 

• Select cell K1, add title “Full Name” 

• Select cell K2
• Enter the formula =CONCAT(H2," ", I2, " ", J2)

• Copy formula down (double-click or drag down + in corner of cell)

• Select column K

• Right click and select “Copy”

• Right click again and select - Paste Value 123 icon 
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Verify Teacher Course Pivot Table - Proper Cert Flag

Create Pivot Table
• From Insert Tab, select Pivot 

Table 

• Select OK

• Pivot Table Fields to select:
• Columns

• PROPER CERT FLAG

• Rows
• FULL NAME

• **Optional CALC TLC IRN

• Values
• Count of TCHR STATE ID

• Filters
• ** Optional CALC TLC IRN12/08/2022 69

Verify Teacher Course Pivot Table, cont’d 

Verify Total by Teacher

• Why is the teacher certified 
in some courses but not 
others?

• Does the teacher have too 
many courses?

• Do all teachers appear in the 
pivot table? 

Tip - Add “All Borders” from Home Tab  
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Summary
• The TLC Status Report contains both data to verify and issues 

to correct

• Some issues can be corrected, and some are simply stating 
the fact

• Work with district staff to verify that the data is both correct 
and complete

• “No errors” does not necessarily mean that your data is 
complete and accurate

• Use Excel functions to make troubleshooting easier
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Resources 
• (TLCS-001) Teacher Licensure Course Status Report Explanation

• ODE Home > Data > EMIS > Documentation > EMIS Validation and 
Report Explanations 

• EMIS Manual 
• ODE Home > Data > EMIS > Documentation > EMIS Manual

• Credit Flex Information
• https://education.ohio.gov/Topics/Ohio-Education-Options/Credit-Flexibility-Plan
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Resources, cont’d 

• Educator Search 
• https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.UI/
• OH|ID Portal App - Educator Licensure and Records (CORE)

• Certification and Licensure Dictionary
• https://education.ohio.gov/Topics/Teaching/Licensure/Additional-

Information/Certification-and-Licensure-Dictionary

• Office of Educator Licensure 
• 614-466-3593 or 877-644-6338
• educator.licensure@education.ohio.gov

• Your district staff and your ITC
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Questions?
If you would like a certificate of attendance for this 

training, you must complete the below feedback form 
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback
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